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DALSA QuickCam

Welcome.The DALSA QuickCam application allows you to quickly control
and view output from a DALSA camera. Among the many available
options are controlling camera exposure, sensor readout and performing flat
field correction.

Getting Help

The QuickCam application provides context-sensitive help on all dialog boxes,
providing descriptions of specific fields as well as conceptual information related
to those fields.

You can find help from the accompanying user guide or directly from the
QuickCam Help.

e  For context sensitive help, place your cursor in the field where you want
more help and press F1.

or

o  Click the Help button on the tab in QuickCam where you want more
information.

e  For the complete Help, select Help>QuickCam Help on the QuickCam
menu bar. You can find topics from the Help by using the table of contents
and search tool.

Customer Feedback and Support

For additional information or support, contact us at:

Address 605 McMurray Road
Waterloo, Ontario

Canada N2V 2E9

Voice (519) 886-6000

Fax (519) 886-2230

E-mail
Customer Support (support@dalsa.com)
Sales (sales.americas@dalsa.com)

Web http:/ /www.dalsa.com/
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Installing, Connecting,
Detecting, and Saving

2.1 Installing QuickCam and Camera Drivers

To install QuickCam:
1. Insert the camera CD into your CD-ROM drive.

If the installation wizard does not start automatically, click Start on the
Windows taskbar, and click Run. Type D:\Setup, where D is the letter that
corresponds to your CD drive.

2. Click Install QuickCam and follow the online instructions to complete the
installation.

Installing Drivers for Your Camera

If you are using a Spyder3 GigE camera, you must install drivers before
running QuickCam.

Before installing drivers, ensure that your PC is equipped with a GigE network
interface (also referred to as a network adapter) based on Intel’s 82540 chip.
Many motherboard manufacturers are designing this chip directly into their
board in “LAN on the motherboard (LOM)” implementations. Alternately, an
Intel 82540-based network adapter, also known as a network interface card, can
be slotted into a PC.

To install Spyder3 GigE drivers:

1. Open the Driver Installation Tool. On the Windows task bar click Start,
point to Programs - DALSA QuickCam > Tools - Launch Driver
Installation Tool.

If you are using an Intel PRO/1000 adapter:

a) On the Pro 1000 Adapters tab, right click on an Intel PRO/1000
network interface card adapter with no installed driver (i.e. when
the Device Class is Ethernet Controller).

The following context menu appears:
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Install High Performance IP Device Driver. ..
Install Intel Metwork Driver. ..

b) Choose Install High Performance IP Device Driver to install the
QuickCam High Performance IP Device Driver.

If you are NOT using an Intel PRO/1000 adapter:

a) On the Universal IP Filter Driver tab, click, Install Filter Driver.... This
button installs the QuickCam Universal IP Filter Driver on ALL network
adapters installed on the system that are using a network driver. This
excludes PRO/1000 adapters on which the QuickCam High
Performance Driver has been installed.

2.2 Running QuickCam

To run QuickCam:

1. On the Windows task bar, click the Start button, point to Programs -
DALSA QuickCam - DALSA QuickCam

2.3 Connecting, Detecting and Acquiring

03-032-10187-04

Images

Detecting a Camera

When you first open the QuickCam application, and after powering up the
camera, QuickCam automatically detects all cameras on the network and asks
you to set an IP address for each (or accept the suggested default). If you have
multiple cameras on your network, ensure you give each one of them a unique IP
address.

Set Camera’s IP Address &l

MaC Address: |

IP Address: | 192 168 . 2 . 254

Cancel |

If you need to change the device’s IP or name after initial setup, use the Network
Device Finder dialog box (menu bar: Configure - Advanced Connection...).

mm View  Window  He

Language 3
Serial Port Link, k

Time-outs & Packeks, ..
Advanced GPIC..,

Adwanced Connection...

To access the advanced controls, right click on the device you want to configure.

DALSA corp.
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& Network Device Finder E“El@

EE- JDevice (00-11-1C-F0-00-4E) with [P
All the Fallowing commands use the First available adapter

Select Item

SetIP...
Sek Device Mame...

Hide device
WWHWWM—M%WWW

To manually detect a camera:

1. If your camera is not already connected, click the Detect icon on the
toolbar.

The connection to the camera should now be established. If you are having
problems detecting your camera, see section 8.1 Troubleshooting: Cannot Detect
the Camera on page 59.

Disconnecting and Reconnecting a Camera

To disconnect a camera:

1. Open the Connection tab in the Camera Configuration Window.
On the Connection tab:

2. Click Disconnect.

The camera should now be disconnected

Toolbar equivalent: !&'

To reconnect a camera after a disconnection:

1. Open the Connection tab in the Camera Configuration Window.
On the Connection tab:

2. Click Connect.

The camera should now be connected

Toolbar equivalent:
Acquiring Images
After QuickCam has detected your camera, you can begin grabbing images.

To begin grabbing images:

1. Open the Connection tab in the Camera Configuration Window.
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Under Acquisition Control:
2. Click the Start button.
The camera is now grabbing images in continuous mode.

From here you can also select whether or not to allow bad and/or incomplete
images to be acquired by selecting the Bad image passthrough and Ignore
Missing Packets options.

To switch between continuous mode and snapshot mode:

Lad
=
1. Click the button to continuously grab images

or

o 3

Click the button to take a snap shot of the image.

Stopping Image Acquisition

To stop acquiring images:

1. Open the Connection tab in the Camera Configuration Window.
Under Device Actions:

2. Click the Stop button.

"

Toolbar equivalent:

Rebooting a Camera

To reboot the camera:

1. Open the Connection tab in the Camera Configuration Window.
On the Connect/Detect tab:

2. Click the Reset Camera button.

Toolbar equivalent: LJ" .

2.4 Saving and Restoring Camera Settings

03-032-10187-04

Saving Camera Settings

You can save the current camera settings to the camera’s non-volatile memory,
allowing you to use them again after a camera reboot.

DALSA corp.
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Note: Pixel coefficients are saved separately from other settings.

To save camera settings to the camera’s non-volatile memory:
1. Open the Save/Restore tab in the Camera Configuration Window.
Beside User Settings:

2. Click Save to Camera.

Toolbar equivalent: Ead™

With the exception of pixel coefficients, the current camera settings are saved to
the camera’s non-volatile memory.

Restoring Camera Settings

You can quickly restore the last saved camera settings from non-volatile memory
through the Save/Restore tab.

To restore user settings from the camera’s non-volatile memory:

1. Open the Save/Restore tab in the Camera Configuration Window.
Beside User Settings:

2. Click Restore from Camera.

With the exception of pixel coefficients, the last saved camera settings are
restored.

Restoring Factory Settings

On first initialization, the camera operates using the factory settings. You can
restore the camera’s original factory settings at any time through the
Save/Restore tab.

To restore the camera’s factory settings:
1. Open the Save/Restore tab in the Camera Configuration Window.
Beside Factory Settings:

2. Click Restore from Camera.

Saving Camera Configuration to an XML File

You can save the current camera Ethernet configuration to an XML file, allowing
you to reload and re-use the settings at a later time.

To save the camera Ethernet configuration to an XML file:
1. Choose File —» Save XML File....
In the Save As dialog box:
Select the location on your computer to save the file.
In the File name text box, enter a name for the settings script file.
Click Save.
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—
Toolbar equivalent: H

A camera script file is created with the specified file properties.

Loading Camera Configuration from an XML
File

You can load camera system settings from a previously saved XML file. This is
useful when you want to load the same settings on multiple cameras.

To load Ethernet configuration settings from an XML file:
1. Choose File — Load XML File....
In the Open dialog box:

2.  Inthe Look in list, click the drive, folder, or Internet location that contains
the file you want to open.

In the folder list, locate and open the folder that contains the file.
Click the file, and then click Open.

Toolbar equivalent: D

Saving, Loading, and Resetting Pixel
Coefficients

You can save the current FPN and PRNU coefficients to the camera’s non-volatile
memory, allowing you to reload and re-use the coefficients again at a later time.
You can also reset pixel coefficients to zero at any time.

To save or load pixel coefficients:
1. Open the Save/Restore tab in the Camera Configuration Window.
Under Pixel Coefficients:

2. Select the pixel coefficient set number from the Set Number drop down box.
You can save or load up to four different sets of pixel coefficients.

3. Click Save or Load.

The selected pixel coefficient set is now saved or loaded.

f Remember that pixel coefficients must be enabled in order to see their
effect on your image. Refer to 7.7 Enabling and Disabling Coefficients for details.

To reset pixel coefficients to zero:
1. Open the Save/Restore in the Camera Configuration Window.

Under Pixel Coefficients:

DALSA corp.
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2. Select the pixel coefficient set number from the Set Number drop down box.

You can save or load up to four different sets of pixel coefficients.

3. Click Reset.

The selected pixel coefficient set is now set to zero.

To display pixel coefficients:

1. Choose View — Pixel Coefficients on the menu bar.

2. Select the pixel coefficient set number from the drop down box.

The pixel coefficient set displays.

r

Pixel Coefficients E|
Pizxel Coefficient Set | -
L
Pizel: FPN PRNU  FPN PRNU  FPN PRNU  FPN FRNU  FPN FPRNU
1: 16 3795 17 3795 18 3795 19 3795 20 3795
6 21 3795 22 3795 23 3795 24 3795 25 3795
11: 26 3795 27 3795 28 3795 29 3795 30 3795
16: 31 3795 32 3795 33 3795 34 3795 35 3795
21: 36 3795 37 3795 38 3795 33 3795 40 3795 —
26 41 3795 42 3795 43 3795 44 3795 45 3795
31: 46 3795 47 3795 48 3795 43 3795 50 3795
36 51 3795 52 3795 53 3795 54 3795 5L 3795
41: 56 3795 57 3795 58 3795 53 3795 60 3795
46 61 3795 62 3795 63 3795 64 3795 65 3795
E1: 66 3795 67 3795 68 3795 69 3795 70 3795
56 71 3795 72 3795 73 3795 74 3795 75 3795
L 7 L e L1, See || oac v sy
You can save the contents of the Image Output Window in TIFF format, either as
a single frame, or as a series of frames. You can control the size of the frame
using the Width and Height controls in the Display section of the Connection tab.
| Camera Conhiguration Window =
Connection | Fleadout | Exposure/GPI0 | Calbvation | Disgrostics | Save/Restore |
Device Acton: Acouestion Control
I Bad images passtheough
Detect | Start
E: Igrioes Mizsing Packets
Discornect :
Diplay
Rese Width [1024 Heght: [420 -
Active Cameea Irdoemation
Status: Connected
ol e ki e e e, il i i it o i e e e o el e i e Rl ol
Saving a Single Image
To save a single image you must stop acquiring images first (for example, with
the ik button). What you save will be either the last image acquired when you
stopped acquiring (in continuous mode), or an image acquired when you take a
snapshot with the th"' button. To save a single image: M configure view window
Load #ML File. ..
Sawve KML File. ..
Load Macra, ..
Save Log File, ., DALSA wrp.

e Image Output. ..

Exit
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1. From the File menu, select Save Image Output. If this menu option is not
available, you are likely still in continuous acquisition mode; stop acquiring
(use the Stop button in the Connection tab) and the menu option will be
enabled.

2. Inthe Save As file browser, select the location on your computer to save the
image.

3. Click Ok.

The image will now be saved to your computer.

Saving Multiple Image Frames:

You must be acquiring images in continuous mode save multiple image frames.
If you have not already done so, click Start in the Connection window or use the

JJ‘J

button. To save multiple images:

Method 1:
1. Open the Save/Restore in the Camera Configuration Window.

Eonnection] Headout] Exposure.-"GF'ID] Ealibration] Diagnostigs  Save/Restare ] ;

b

Camera Settings
Lger Settings:

Save to Camera | Restare from Camera

Factary Settings: Festare from Camera

Pixel Coefficients

Set Number: - Load | Save | Reset

e ol e g

Frames To Save 4
Frames To Save: |1 :I Save As ;

S S e S S

2. In the Frames to Save spin box, select the number of frames to save.
Click Save As.

In the Save As file browser, select the location on your computer to save the
frames.

5. Click Ok.

The selected number of frames will now be saved to your computer.

Method 2: FEN Corfigure  Wiew  Window
From the File menu, select Save Image Frame(s). Load =ML File...
. Save XML File...
2. From the Frames to Save spin box, select the
number of frames to save. Load Macro,..
Click Save. Save Log File..,

In the file browser, Select the location on your
computer to save the frames.

5. Click Ok.

The selected number of frames will now be saved to
your computer.
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Viewing, Resizing, and
Moving the Image

3.1 Viewing an Image

After you have detected your camera and started grabbing images, you can view
the images in the Image Output Window. Refer to Chapter 1 if you need more
information on how to detect a camera and begin grabbing images.

To view what the camera is currently imaging:

1. Select Window - Image Output Window to show the Image Output
Window.

The image should now be displayed in the Image Output Window.

3.2 Viewing a Saved Image

Method 1:

1. From the Camera Display Window, select the file the images were saved to.
By default this will be the “Images” file.

2. Double click the name of the image you want to view.
The image will display in the Image Output Window.
Method 2:

1. From the File menu, select Load Image Output.

2. In the file browser, locate the file the image was saved to and select the
image.

3. (Click Open.
The image will display in the Image Output Window.

3.3 Resizing the Image

03-032-10187-04

You can adjust the image size in the Image Output Window to either fit to the
window size or display the image at actual size.
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To resize the image:

1. Click the J button on the toolbar to fit the image to the size of the
Image Output Window.

or

J;i
Click the

button on the toolbar to view image at its actual size.

3.4 Zooming In or Out of an Image

You can "zoom in" to get a close-up view of your image or "zoom out" to see
more of the image at a reduced size.

To change the zoom level:

1. Click the 1\3 button to zoom in on the image.

or

Click the l\ﬁ

button zoom out on the image.

3.5 Moving the Image in the Window

03-032-10187-04

You can “unlock” an image in order to move it around the Image Output
Window. This feature is useful when viewing areas of an image that has been
zoomed in on.

1. Open the image you want to move in the Image Output Window.
2. Right click on the image and uncheck the “Lock on center” option.

3. You can now left-click-and-hold on the image in order to drag it around the
window.

Note that the ROI feature, as well as features dependent on set X & Y
coordinates, will be affected if the image is moved.
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Configuring Image
Readout

4.1 Overview: Configuring Image Readout

To configure image readout:

1.

Open the Readout tab in the Camera Configuration Window.
Under Readout:

Select the sensitivity mode to use from the Sensitivity Mode dropdown box.
For details, see Setting the Camera's Sensitivity Mode.

Select the bit depth to use from the Bit Depth dropdown box. For details, see
Selecting the Camera's Bit Depth.

Select the camera’s CCD shift direction from the Direction dropdown box.
For details, see Changing the Camera's CCD Shift Direction.

Under Binning;:

Select the horizontal binning value from the Horizontal Binning dropdown
box. For details, see Using Horizontal Binning.

To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

4.2 Setting the Camera's Sensitivity Mode

03-032-10187-04

You can operate the camera in high sensitivity, low sensitivity, or tall pixel mode.

To set the camera’s sensitivity mode:

1.

Open the Readout tab in the Camera Configuration Window.
Under Readout:

Select the sensitivity mode to use from the list in the Sensitivity Mode
dropdown box where:

High Sensitivity: The camera uses both line scan sensors and its
responsivity increases accordingly
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Low Sensitivity: The camera uses a single line scan sensor.

Tall Pixel: The camera operates using both sensors, creating a 28um x 14um
pixel.

3. To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

4.3 Selecting the Camera's Bit Depth

You can output either 8 or 12 bits.

To set the camera’s bit depth:
1. Open the Readout tab in the Camera Configuration Window.
Under Readout:
Select the bit depth to use from the list in the Bit Depth dropdown box.

To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

4.4 Changing the Camera's CCD Shift

Direction

When in high sensitivity mode, you can select either forward or reverse CCD
shift direction or external direction control. This accommodates object direction
change on a web and allows you to mount the camera "upside down".

To set the camera’s readout direction:
1. Open the Readout tab in the Camera Configuration Window.
Under Readout:
Select the direction to use from the list in the Direction dropdown box.

To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

5 Available only in high sensitivity mode.

4.5 Using Horizontal Binning

03-032-10187-04

Horizontal binning increases the horizontal pixel pitch and light sensitivity by
decreasing horizontal resolution. The amount of data being sent from the camera
is reduced by the horizontal binning factor.

To set the horizontal binning factor:
1. Open the Readout tab in the Camera Configuration Window.
Under Binning;:

2. Select the horizontal binning factor to use from the list in the Horizontal
Binning dropdown box.

DALSA corp.
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To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

@ Notes on Binning

For optimal flat field correction, you should rerun the flat field correction
after changing binning values.

Changing binning values does not automatically alter gain, frame rate
generation, or other functions of the camera. You may, however, have to re-
enter the camera’s frame rate after changing binning values.

DALSA corp.
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Exposure Control

5.1Exposure Control

03-032-10187-04

Overview: Exposure Control

Using the Exposure/GPIO tab in the Camera Configuration Window, you can
control the camera’s exposure mode, line rate, and exposure time.

To select how you want the camera’s line/frame rate to be generated:

1. Inthe Exposure Mode dropdown box, first select the camera’s exposure
mode. For details, refer to Setting the Camera's Exposure Mode.

2. Next, if using an internally generated sync, you must set the camera’s line
rate in the Line Rate (Hz) text box. This option is grayed out and not
available when using an external sync. For details, refer to Setting the
Camera's Line Rate and Exposure Time.

3. Finally, if applicable to your exposure mode, set the exposure time in the
Exposure Time (us) text box. This option is not available in some exposure
modes and is grayed out. For details, refer to Setting the Camera's Line Rate
and Exposure Time.

Setting the Camera's Exposure Mode

You have a choice of operating the camera in one of the multiple exposure
modes. Depending on your mode of operation, the camera’s line/frame rate
(synchronization) can be generated internally or set externally with an EXSYNC
signal (CC1).

To select the camera’s exposure mode:
1. Open the Exposure/GPIO tab in the Camera Configuration Window.
Under Exposure:

2. Select the exposure mode to use from the list in the Exposure Mode
dropdown box.

3. To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

Note: Refer to the camera user’s manual for detailed timing diagrams.
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Setting the Camera'’s Line Rate and Exposure
Time

Depending on the camera’s exposure mode, you can set the camera’s line rate
and/or exposure time. These options are grayed out when you are operating the

camera in an exposure mode that does not allow you to set these
programmatically.

Please note that the exposure time range is calculated based on the current line rate. For
example, in exposure mode 2, a line rate of 5000 Hz allows for a maximum
exposure time of 197.50 pus; whereas, a line rate of 4000 Hz allows for a maximum
exposure time of 247.50 ps.

Use the command get ger in order to have the camera return the maximum
exposure time for the current line rate.

To set the camera’s line rate:
1. Open the Exposure/GPIO tab in the Camera Configuration Window.
Under Exposure:

2. Enter the line rate to use by sliding the slider or typing the value in the Line
Rate(Hz) textbox.

3. To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

&

To set the camera’s exposure time:

This option is available only when operating in exposure modes 2 or 7.

1. Open the Exposure /GPIO tab in the Camera Configuration Window.
Under Exposure:

2. Enter the exposure time to use by sliding the slider or typing the value in the
Exposure Time(us) textbox.

3. To save the settings to the camera’s nonvolatile memory, click Save Camera
User Settings.

%

This option is available only when operating in exposure mode 2

22
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GPIO Control

The GPIO connector allows the camera to receive (and in some cases output)
direct, real-time control signals that are independent of Ethernet
communications. Ethernet network protocols introduce a small but measurable
and unpredictable lag that does not allow extremely precise and reliable control
of camera behavior such as line rate, integration time, and readout direction.

For example, the GPIO connector can be used to control EXSYNC, PRIN (pixel
reset), and direction signals.

In general, to configure the GPIO, you need to accomplish three main tasks:
1. Assign a physical camera pin and signal to a GPIO Input number.

2. Map the GPIO Input or Output from the Exposure/GPIO tab to the
corresponding GPIO Look-Up Input Configuration.

3. Using the LUT programming language, map the GPIO Input Configuration
to the GPIO Output Configuration.

The following sections provide details on the LUT control block, the LUT
programming language and the advanced features of the GPIO.

6.1 The GPIO Control Block

03-032-10187-04

All signals pass through the GPIO Control Block. Depending on its
programming, the GPIO Control Block generates output signals that can be
redirected to various camera outputs.

The GPIO control block uses a look up table (LUT) to generate the outputs. This
LUT contains eight different inputs, each of which can generate 18 different
outputs, resulting in 256 entries of 18 bits.

DALSA corp.
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. TRIC of1e] Ndban Gebee [ Gonret
TS_TRIG[0] —p J\lﬁ'l 17 Counter —» GP_CNT_(
TS_TRIG[1] —P v GP_CNT[31:0] ——] Timestamp S TRIGH-O
.
TS_TRIG[2] —p] TS_CNT[31:0] ——] omigger > TS_TRIG[3:0]
TS_TRIG[3] Q[17,16,ll,10,9,8,7,3]>8_ clear )
> : Timest .
Q[17,16,11,10,9,8,7,3] Sgdset gﬁifﬁp — TS_CNT[31:0]
Note that all external inputs (from the camera, TTL inputs, and GPIO controls)
are resynchronized. The outputs from the look-up table are synchronous.
The LUT is programmed using a simple language. This language allows you to
create logical equations that specify the conditions that set particular outputs. See
also: GPIO Control Block Programming Language
@ Note: There is a delay of two clock cycles between the inputs of the LUT
and its outputs. A clock cycle has a period of 30 nanoseconds, so the delay is 60
nanoseconds.
The signals in the GPIO Control Block are defined in the tables below.
Inputs to QuickCam are labeled In (where n is an integer from 0 to 7) and
outputs are labeled Qn (where n is an integer from 0 to 15).
Input Signal Label | Description
GPIO_INJ0] * GPIO 0 input
GPIO_INJ1] GPIO 1 input
GPIO_INJ[2] GPIO 2 input
03-032-10187-04 DALSA corp.
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Input Signal Label | Description
GPIO_INJ[3] GPIO 3 input
CAM_INJO0] Camera input 0
CAM_INJ1] Camera input 1
CAM_INJ2] Camera input 2
CAM_INJ3] Camera input 3

GPIO_CTRL[0]

GPIO 0 control bit. The control bits are internal to
QuickCam and can be controlled by the SDK.

GPIO_CTRL[1]

GPIO 1 control bit. The control bits are internal to
QuickCam and can be controlled by the SDK.

GPIO_CTRL[2]

GPIO 2 control bit. The control bits are internal to
QuickCam and can be controlled by the SDK.

GPIO_CTRL[3]

GPIO 3 control bit. The control bits are internal to
QuickCam and can be controlled by the SDK.

PULSE_OUTO0 Output from pulse generator 0
PULSE_OUT1 Output from pulse generator 1
PULSE_OUT?2 Output from pulse generator 2
PULSE_OUT3 Output from pulse generator 3

GPIO_OUT[2]

Direct feedback from the LUT output assigned to
GPIO_OUT[2]

GPIO_OUTJ[3]

Direct feedback from the LUT output assigned to
GPIO_OUTI3]

Direct feedback from the LUT output assigned to

CAM_CTRL][3] CAM_CTRL[3]
Direct feedback from the LUT output assigned to
CAM_CTRL[4] CAM_CTRL[4]
RSL_OUT Output from rescaler 0
DEL_OUT Output from delayer 0
Output of counter 0. Low when the counter’s value
is lower than or greater than a specified comparison
GP_CNT_EQ value. High when the value is equal to the specified
comparison value.
Output of counter 0. Low when the counter’s value
GP_CNT_GT is lower than a specified comparison value. High

when the value is equal to or greater than the
specified comparison value.

GPI0 Output Labels

Input Signal Label Description

GPIO OUTPUT 0 Qo GPIO output 0

GPIO OUTPUT 1 Q1 GPIO output 1

GPIO OUTPUT 2 Q2 GPIO output 2

GPIO OUTPUT 3 Q3 GPIO output 3

EXSYNC Q4 EXSYNC

PRIN Q5 PRIN

DIRECTION Q6 Camera forward and reverse control.
Sg]é\;[)—_CTRL (NOT Q7 CC4 signal. Not used.

PULSE_TRIG1 Q8 Trigger for pulse generator 1. Used only when

DALSA corp.
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Input Signal

Label

Description

the pulse generator is in triggered mode.

If available, can be used by one of the following
modules:

e Rescaler 0 input

e Delayer 0 reference signal

e Counter 0 clear event input

e Timestamp counter set event input

e Timestamp counter clear event input

PULSE_TRIGO

Q9

Trigger for pulse generator 0. Used only when
the pulse generator is in triggered mode.

If available, can be used by one of the following
modules:

e Rescaler 0 input

e Delayer 0 reference signal

e Counter 0 clear event input

e Timestamp counter set event input
Timestamp counter clear event input

PULSE_TRIG3

Q10

Trigger for pulse generator 3. Used only when
the pulse generator is in triggered mode.

If available, can be used by one of the following
modules:

e Rescaler 0 input

e Delayer 0 reference signal

e Counter 0 clear event input

e Timestamp counter set event input

Timestamp counter clear event input

PULSE_TRIG2

Qi1

Trigger for pulse generator 2. Used only when
the pulse generator is in triggered mode.

If available, can be used by one of the following
modules:

e Rescaler 0 input

e Delayer 0 reference signal

e Counter 0 clear event input

e Timestamp counter set event input
Timestamp counter clear event input

GPIO_FVAL

Q12

Output to the internal grabber to replace or mix
with the camera’s FVAL signal. Depending on
the camera, the FVAL signal can be replaced or
combined with the signal of this output.

GPIO_LVAL

Q13

Output to the internal grabber to replace or mix
with the camera’s LVAL signal. Depending on
the cameral, the LVAL signal can be replaced or
combined with the signal of this output.

GPIO_TRIG

Q14

Trigger of image grabber when configured to
use hardware trigger.

26
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Input Signal Label Description

Trigger for an application callback. When the
callback is invoked, it provides the following
information:

GPIO_IRQ Q15 e A bit mask of the 8 LUT inputs at the
time the interrupt was generated.

e The timestamp value at the time of the
interrupt.

Trigger for the down event of counter 0.

If available, can be used by one of the following
modules:

e Rescaler 0 input

CNT_DOWN Q16 e Delayer 0 references signal
¢  Counter 0 clear event input
e Timestamp counter set event input
e Timestamp counter clear event input
Trigger for the up event of counter 0.
If available, can be used by one of the following
modules:
e Rescaler 0 input
CNT_UP Q17

e Delayer 0 references signal
e Counter 0 clear event input
e Timestamp counter set event input

e Timestamp counter clear event input

6.2 GPIO Control Block Programming
Language

The GPIO Control Block is programmed using a simple, yet very flexible
language.

By default, the GPIO Control Block will not generate output signals, regardless of
the state of the input signals. The program consists of zero or more lines that
specify how an output signal is generated based on the input signals. Basically
each line of the program has the following format:

Qn = <logical expression of inputs: In>

Therefore, a program line can range from a simple redirection from one input to
one output, to a complex logical expression of two or more input signals.

The language uses generic labels for inputs and outputs.
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To configure the GPIO Look-Up Table from the user interface or SDK functions,

the following language is used:

language
line

eol

output

group
not_group
and

or

xor

combined_expression

expression

false
true
input

not_input

*(I
eol

‘\r,

ine )

] output

I “\n” | "\r\n" | "\n\r"
"QO™ | QLT | Q2T | Q3T | Q4T | Q5" |

28

combined_expression [ eol ]

"Q6" | Q7 | Q8" | Q9T | "Q107 | Q11" |

Q12 | Q13 | Q14 | Q15"

‘s
<y-
g
10

enz

combined_expression “)~’

group
expression
expression

expression

expression *( and | or | xor )

input | not_input |
false | true |
group | not_group

0>

<q1-

10"
et

| “false” | “FALSE"

| “true™ | "TRUE"

| 112 ] 1z2e ] st
| 16" | 17"
input

Y
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6. 3 Configuring the GPI10 (With Examples)

Overview

As was mentioned in the introduction of this chapter, to configure the GPIO, you
need to accomplish three main tasks:

Step 1

The first step is to select and assign the GPIO connector pins and signal type to
use for any necessary inputs or outputs.

Connection Exposure/GPIO l Readout ] Calibration ] Diagnostics ] Save/Festore ]
Exposure
Bposure Mode: |?: Programmable line rate & max exposure timej
Line Rate{Hz); — | Yy | 5000 il

Exposu Assign a physical camera pin —:I
and signal to a GPIO Input
GA number.
Advanced...

PDisabled
GFIO Input 1: |Disabled

GPIO Input 2: | Disabled
GFIO Input 3: |Disabled

GPIO Output 0: |High Z. Fin 11 & Pin 12

GPIO Output 1: |High Z, Pin 13 & Pin 14
GFIO Output 2: [High Z, Fin 15 & Pin 10

Lol Lol Lef Lo L] Lo Laf Led

GPIO Output 3: [High Z. Pin 9

Save Camera Settings

L
o
=]
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Step 2

Next you must map the GPIO input number and signal type set on the
Exposure/GPIO tab to a GPIO Look-Up Table Input Configuration Label.
L —ar —_— |

— GPIO

Advanced... |

el T R Active Operation, TTL, Pin 1

N

Configuration - Advanced GPIO Input 1: | Disabled =~
GPIO Input 2: | Disabled |
GPIO Control Bits I Port Communication | lap Heconstruction |
Image Settings | Pi (
Delver 0 Map the GPIO Input or Output from the ﬁ
yer Exposure/GPIO tab to the corresponding
Counter 0 GPIO Look-Up Input Configuration
=I| GPIO Look-U)
Input 0 Configurati GPIO Input 0

Input 1 Configuration GPIO Input 1
Input 2 Configuration GPIO Input 2

Input 3 Configuration GPIO Input 3
Input 4 Configuration GPIC Control Bit 1

Input 5 Configuration GPIO Control Bit 0

Input & Configuration Pulse Generator 1 Output

Input 7 Configuration Pulse Generator 0 OQutput
Q4=I0

LUT Program

| InputDahb inn

| GP] Using the LUT programming
+ | Tim| language, map the GPIO ;I
Pulse| Input Configuration to t!le

pulse o GPIO Output Configuration.

¥ Show advanced corfiguration pages oK I Close Apply

Step 3

The final step maps the GPIO Look-Up Input Configuration Label to a GPIO
Output Configuration Label.
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Example: Setting a Simple EXSYNC

1. Assuming you are using a TTL signal, assign GPIO Input 0 to Active
Operation, TTL, Pin 1.

- iy et e T 1\._,— JQI . -"'.J—f‘- Croren. _.»""' .
Exposure Time (us): -.j. o 3“ 100.00 ﬁ \
— GPIO {
Advanced... ‘
GPIO Input 0: |Active Operation, TTL. Pin 1 b
. | Disabled
GFIO Inpt 1: Active Operation, TTL, Fin 1
GPIO Inpt 2: I.F'ndive Operation, LVDS, Pin 1 & Pin 2 __
GPIO Input 3: | Disabled | f
' ""ﬂu’u.-mw_. T o ‘,-‘\____h.“‘]‘__h&f.

2. Click Advanced to open the Configuration dialog box.
| EXposURE IMe sy 4 3” 100.00 - |

GPID
Advanced... |

GPIO Input 0: | Active Operation, TTL, Pin 1

3. In the Configuration dialog box, open the Device Features tab.

Configuration - Advanced

GPIO Control Bits |

Port Communication I Tap Reconstruction I RGE Fitter |

Image Settings I Fixel Type I Grabber Settings I Grabber Features Device Features
= Flow Control 1<
Inter Packet Delay 0
Inter Packet Delay (ns)
Expected Data Rate (... | 100000000
_ Link Speed 1000 MBits/seconds
R e TR AW LN DV

03-032-10187-04
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4. On the Device Features tab, open the GPIO Look-Up tree.

Configuration - Advanced i[

GFIO Control Bits |
Image Settings | Piel Type | Grabber Settings | Grabber Features

Port Communication I

Tap Reconstruction

|  RGEFiter |

Device Features

0 B HHEBBEEEHH

Flow Control

e

Pulse Generator 0

Pulse Generator 1

Pulse Generator 2

Pulse Generator 3

Rescaler 0

Delayer 0

Counter 0

GPID Look-Up Table

Input 0 Configuration

GPIO Input O

Input 1 Configuration

GPIO Input 1

Input 2 Configuration

GPIO Input 2

Input 3 Configuration

GPIO Input 3

Input 4 Configuration

GPIO Control Bit 1

Input 5 Configuration

GPIO Control Bit O

Input & Configuration

Pulse Generator 1 Output

Input 7 Configuration

Pulse Generator 0 Qutput

Mo Item Selected
Select an item to see its description or right-click its label for more options,

32

[¥ Show advanced corfiguration pages

ok |

Apply
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5. In the Input 0 Configuration, map GPIO Input 0 to the Input 0 Configuration

label.

e B T et T e e T st e A S P bt el
_? Pulse Generator 2

: Pulse Generator 3

b

;; Rescaler D 4
:.j Delayer 0

_? Counter 0

% = GPIO Look-Up Table

%

3 Input 0 Configuration GPIQ Input 0

; —

i Input 1 Configuration GPFIO Input 0

4 Frame Valid

‘il Input 2 Configuration GPIO Input 1

3 ] GPIO Input 2

ﬁ.;" Input 3 Configuration Line Valid

ks Input 4 Configuration Data Valid

¢ _ GPIO Control B0

i | |Input 5 Configuration GPIO Control Bit 1

b : GPIQ Control Bit 2

i Input & Configuration

i B 3 02 (feedbadd

{, Input 7 Configuration CC3 (feedbadk)

5 Pulse Generator O Output I
% | Input 0 Configuration Pulse Generator 1 Output

4 Rescaler 0 Output

: Reserved
4 Reserved
1

Rha e e e vy e e o R e R rp——

6. In the LUT Program text box, enter the equation to map Input 0
Configuration (I0) to Output 4 (Q4) where Output Label = Input Configuration
Label. If you refer to the GPIO Output Label table on page 25, you'll see that
Output 4 is the LUT label for EXSYNC.

I"u._ __,-I:J'L'b-’\u'-\i.-ﬂv: ) - = _ P e A
0 Hem =it _.'ﬂ—".-/f‘_.'-- = _-F'-_“'-'r T = =
< Input 1 Configuration GPIO Input 1
- Input 2 Configuration GPIO Input 2
. Input 3 Configuration GPIO Input 3
.| Input 4 Configuration GPIO Control Bit 1
S| Input 5 Configuration GPIO Control Bit 0
E Pulze Generator 1 Output

*p | Input & Configuration

¥
\T Input 7 Configuration

ﬂ Input Debouncing

Pulse Generator O Output

Q4=I0

A

03-032-10187-04
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7. Click Apply.

- B
S - v.-/ S et i PR |

— O s -
g
¥
¢
L
4

#E 0K | Cloze | ﬁppw

Example: External Sync with Pulse Generator

03-032-10187-04

In this example, a variation on the previous one, pulse generators are used to
provide a periodic trigger to the camera.

The camera uses the signal to receive both the frame rate and the exposure time.
The frame rate varies, depending on the period of the signal and the exposure
time on the width of the signal.

To get a rate of 10 frames per second, the signal needs to have a period of 100 ms.

The desired exposure time is 21 ms.

First the pulse generator 0 needs to be configured to the correct value. In the
pulse generator section of the Device Features tab, shown in the following figure,
the following values would be specified:

e Delay: 12530

e Width: 3334

e  Granularity: 209
e Periodic: TRUE

e Trigger Mode: irrelevant in periodic mode

With the pulse generator 0 correctly set up, its output simply needs to be
redirected to the camera.

Here is a short summary of the outputs and inputs that would be used:
e  Periodic Pulse Generator 0: 17
e EXSYNC label: Q4

The resulting program would look like this:

° Q4=I7

34
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Example: Pulse Generator Configuration for 100 ms Period and 21 ms Exposure Time

Configuration - Advanced ﬂ

GFIO Control Bts | Port Communication |  Tap Reconstuction | RGB Fiter |
Image Settings | Pixel Type | Grabber Settings | Grabber Features ~ Device Features

=l Pulse Generator 0

Width 3334

Delay 12530

Granularity 210

v e

Trigger Mode Triggered an rising edge

Pulze Period (ns) 153630

Pulse Frequency {Hz) 6503, 145349

I+ | Pulse Generator 1
[+ | Pulse Generator 2
| Pulse Generator 3
+ | Rescaler 0

¥ | Delayer 0

| Counter 0

[+ | GPIO Look-Up Table
+ | Input Debouncing ;|
Periodic

¥ Show advanced configuration pages QK I Close Apphy

With the pulse generator 0 correctly set up, its output simply needs to be
redirected to the camera.

Here is a short summary of the outputs and inputs that would be used:
e  Periodic Pulse Generator 0: I7
e  Camera Control 1 (output): Q4
e The resulting program would look like this:
Q4 = 17

6.4 GPIO Look-Up Table

The GPIO Look-Up Table tab is used to configure how the QuickCam software
handles and redirects inputs and outputs. (This differs from the signals set on

03-032-10187-04 DALSA corp.



QuickCam User's Manual

03-032-10187-04

36

Exposure/GPIO tab where you are setting how the camera handles it physical
inputs and outputs.)

Configuration - Basic E|
Image Setfings | Povel Type | Grabber Seltings | Grabber Featwes Device Features |
+ Flow Control
4 Pulse Generator 0
= GPID Look-Up Table
Ingpast O Configur ation GPIO Input O
Inpast 1 Configuration GPIO Inpuk 1
Input 2 Configuration | GPIO Inpast 2
Input 3 Configuration | Line alid
Input 4 Configuration GPIO Control Bit 1
Input S Configuration GPIO Cantral Bit O
Ingat & Configuration Pulse Generstor | Output
Ingast 7 Configuration Pulse Generatar 0 Qutput
LUT Program
Mo Item Selected
Selact an ibem bo see s description or right-chck its [sbel For more aptions,
I Show advanced configuiation pages | oK. | Cose | Apph |

Input 0 Configuration

Selects the input associated with the label 10. This should match the input setting
for Input 1 on the Exposure/GPIO tab.

Input 1 Configuration

Selects the input associated with the label I1. This should match the input setting
for Input 2 on the Exposure/GPIO tab.

Input 2 Configuration

Selects the input associated with the label I12. This should match the input setting
for Input 3 on the Exposure/GPIO tab.

Input 3 Configuration

Selects the input associated with the label I3. This should match the input setting
for Input 4 on the Exposure/GPIO tab.

Input 4 Configuration
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Selects the input associated with the label 14.

Input 5 Configuration
Selects the input associated with the label I5.

Input 6 Configuration
Selects the input associated with the label I6.

Input 7 Configuration

Selects the input associated with the label 17.

LUT Program

The GPIO Control Block is programmed using a simple, yet very flexible
language.

By default, the GPIO Control Block will not generate output signals, regardless of
the state of the input signals. The program consists of zero or more lines that
specify how an output signal is generated based on the input signals. Basically
each line of the program has the following format:

Qn = <logical expression of inputs: In>
Therefore, a program line can range from a simple redirection from one input to
one output, to a complex logical expression of two or more input signals.
The language uses generic labels for inputs and outputs.

To configure the GPIO Look-Up Table from the user interface or SDK functions,
use the language described in GPIO Control Block Programming Language.

6.5 Pulse Generator

03-032-10187-04

To configure the Pulse Generator, click the Advanced... button on the
Exposure/GPIO tab in the Camera Configuration dialog box and open the
Device Features tab.

The Pulse Generators are located on the Device Features tab.

The behavior of the Pulse Generator is defined by their delay and width. The
delay is the amount of time the pulse is inactive prior to the pulse, and the width
is the amount of time the pulse is active.

The Pulse Generator signals can be set in either triggered or periodic mode. In
triggered mode, the pulse generator is triggered by either the rising edge or high
level of the input signal. When triggered, the pulse generator is inactive for the
duration of the delay, then active for the duration of the width. After that, it will
become inactive until the next trigger occurs. If a trigger occurs while pulse
generator is already handling a previous trigger, the new trigger is ignored.

In periodic mode, the trigger continuously generates a signal that is based on the
configured delay and width. The period of the pulse is therefore the delay time
plus the width time.
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Configuration - Advanced E|

GPIO Conbiol Bits |  Pot Communication |  TapReconstuction |  RGE Flter |
Image Seltings | Pixel Type | Grabber Setlings | GrabberFeatues  Device Featuses

+  Flow Control

= | Pulse Generator O
Whdth 4096
Dielany 1024
Grarudarity o
Periodic O raise
Trigger Madse Triggared on rising edge
Pulse Period {ns)
Pulse Fraquency (Hz)

* Pulse Generator 1

* Pulse Generator 2

* Pulse Generator 3

+ Rescaler 0

goetver,o |
* Counter O

+ | GPIO Look-Up Table

* Input Debouncing

+ GPIO Configuration

Delayer 0
Deelaiear O

W Show advanced conbiguation pages il | Close | Apply |

Pulse Generator 0 to 3

Selects which pulse generator to configure. To view the pulse generator
properties, open the directory

Width

Indicates the number of cycles (also determined by the granularity) that the pulse
remains at a high level before falling to a low level.

Delay

Indicates the number of cycles (also determined by the granularity) that the pulse
remains at a low level before rising to a high level.

Granularity

Indicates the number of PCI clock cycles that are used for each increment of the
delay and width. The amount specified in the granularity is multiplied by 30
nanoseconds.

Trigger Mode

Indicates how a triggered pulse generator will handle its triggers. The possible
settings are:
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o Triggered on rising edge: Indicates if a triggered pulse generator is
triggered on the rising edge of an input

e Triggered on high level: Indicates is a triggered pulse generator is
triggered on the high level of an input

e Triggered on falling edge: Indicates if a triggered pulse generator is
triggered on the falling edge of an input

e Triggered on rising AND falling edges: Indicates if a triggered pulse
generator is triggered on the rising edge of an input and on the falling edge
of an input

o Triggered on low level: Indicates if a triggered pulse generator is triggered
on the low level of an input

Pulse Period (ns)

Displays the value of the parameter, in nanoseconds, of a complete delay-width
cycle of the pulse generator. This value is computed every time the delay, width
or granularity is modified and is available regardless of the periodic mode.

Pulse Frequency (Hz)

Displays the frequency of the pulse generator. This value is computed every time
the delay, width or granularity is modified and is available regardless of the
periodic mode.

Pulse Generator Timing
Positive Pulse Generated from a Rising Edge Trigger

Trigger ﬂ ﬂ
Pulse_Out

T e

pulse_delay pulse_width

Negative Pulse Generated from a Level High Trigger

Trigger
Pulse_Out

uThe i

pulse_delay pulse_width

QuickCam can generate two internal signals using the internal pulse generators.
The behavior of each of these two pulse generators is defined by a delay and a
width. As shown in the accompanying diagrams, the delay is the time between
the trigger and the pulse transitions. The width is the time the pulse stays at the
active level before transitioning. The periodic mode, the delay determines the
low time of the pulse.

Each pulse generator generates a signal that can be used as an input to the GPIO
Control Block. A triggered pulse generator needs an input signal that comes from
an output of the GPIO Control Block.

DALSA corp.



QuickCam User's Manual

40

Note: There is one clock cycle between the output signal of a pulse generator and
the outputs of the GPIO Control Block.

The labels for the inputs from the pulse generators in the GPIO Control Block
programming languages are:
e 17, for pulse generator 0

e 16, for pulse generator 1

6.6 Rescaler

03-032-10187-04

To configure the Rescaler, click the Advanced... button on the Exposure/GPIO
tab in the Camera Configuration dialog box and open the Device Features tab.

QuickCam has a rescaler module that can be used to rescale a periodic input
signal. The signal output is resynchronized based on the rescaler settings.

Configuration - Advanced r)_(“|

GPIO ControlBits |  Port Communication | TapRecorsbucion | FGBFiter |
Image Seltings | Picel Type | GrabberSetlings | GrabberFeatues  Device Fealses
+ Pulse Generator 1 iy

+  Pulse Generator 2
+ Pulse Generator 3
= Rescaler 0
Grandariy 1 PCI clock cycle
Multipher Frequency ¥ 256
Divider 256
Inputt Selection Q3
Backuip Enabled O Facse
Backup Window o
Backup Input Pulse Generator #0
Input Frequency
Cuitput Frequency
Target Frequency | 1
Recommended Granudarity
Recommendead Mulipier
Recommendead Divider
Rescalar Size e

Mo Item Selected
Selact an [bem Lo sae s description of right-chck its label for more aptions,

¥ Show advanced configurstion pages [ oK | Close | Apply |

The rescaler is defined by the following settings:

Granularity

The granularity is the number of clock cycles during which the rescaler checks
for activity on its input. The value to use depends on the period/frequency of the
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input signal. If a frequency lies between two different granularity settings, the
lowest setting will yield a better precision. The possible values are:

1 PCI clock cycles: The frequency of the input signal is between 509Hz and
33.3MHz.

4 PCI clock cycles: The frequency of the input signal is between 128Hz and
8.3MHz.

16 PCI clock cycles: The frequency of the input signal is between 32Hz and
2.08Mhz

256 PCI clock cycles: The frequency of the input signal is between 2Hz and
130.2kHz

Multiplicator
The multiplier applied to the input frequency. The possible values are:

e Frequency is multiplied by 256
e Frequency is multiplied by 16
e Frequency is multiplied by 4096

Divider
The divider applied to the input frequency. The resulting frequency is computed
as follows:

input _ frequencyxmultiplicator
divider

output _ frequency =

Input Selection

Indicates which label in the GPIO LUT will be associated with the rescaler. Make
sure you select an input label that is not being used for its default behavior. For
example, Q9 is used to send a trigger to pulse generator 0. If pulse generator 0 is
used in triggered mode, then it will be triggered by Q9 and cannot be used as the
input for the rescaler. The possible values are: Q3, Q7, Q8. Q9, Q10, Q11, Q16,
and Q17.

Backup Enabled

Indicates if the rescaler will use a back-up input source if its main source stops its
activity.

Backup Window

Specifies the window of time during which there can be no activity from the
main input source before the rescaler switches to the back-up source. As soon as
activity is detected, the rescaler returns to its main input source.

Backup Input

Same as the main input source

Target Frequency

Helper parameter that computes the best rescaler value of a given target
frequency.

Recommended Granularity
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Provides the recommended granularity for the value specified in the Target
Frequency

Recommended Multiplier

Provides the recommended multiplier for the value specified in the Target
Frequency

Recommended Divider

Provides the recommended divider for the value specified in the Target
Frequency

The output of the rescaler is considered an input for the GPIO LUT.

The labels for the output from the rescaler in the GPIO Control Block
programming languages depend on the LUT input configuration.

6.7 Counter

03-032-10187-04

To configure the Counter, click the Advanced... button on the Exposure/GPIO

tab in the Camera Configuration dialog box and open the Device Features tab.

QuickCam has general purpose counter module. It simply maintains a count
value that can be increased, decreased, or cleared based on input signals. The
counter outputs two signals (which are inputs to the GPIO LUT)

42
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Configuration - Advanced E]
GPIO ConrolBits |  Port Communicstion |  TapReconstuction |  RGE Fter |
Image Settings | Pieel Type | GrabberSeflings | GrabberFeatues  Device Featses
+ Flow Control i

+ Pulse Generator 0
+ Pulse Generator 1
+ Pulse Generator 2
+ Pulse Generator 3

+ Rescaler 0

+ Delayer 0

= Counter O
Lip Event Disabled
Dowin Eveenit | Disabled
Clear Event Disabled
Input Q3
Compare Yalus 0
Current Counber Valoe

+ GPIO Look-Up Table

+ Input Debouncing

+ GPIO Configuration

+ Timestamp Counter W

Mo Item Selected
Selact an [bem Lo sae s description of right-chck its label for more aptions,

¥ Show advanced configuiation pages [ ok ]| e | Ay |

Up Event

Specifies how the input for incrementing the count is handled. The counter’s up
event uses the Q17 label in the LUT. It can be one of the following settings:

e Disabled

¢  On the rising edge
¢ On the falling edge
e Onboth edges

¢ On the high level

e  On the low level

Down Event
Same as above but for the down event, but uses the Q16 label in the GPIO LUT.

Clear Event
Same as above but for the clear event. The clear event input of the counter does
not have a predefined label on the GPIO LUT.

Input
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Indicates which label from the GPIO LUT that will be associated with the clear
event input of the counter. Make sure you select an input label that is not being
used for its default behavior. The possible values are: Q3, Q7, Q8, Q9, Q10, Q11,
Q16, and Q17.

Compare value

Indicates the value against which to compare to the current value of the counter.
The counter module uses this value to generate both its "equal to" and "greater
than" outputs.

Current Counter Value

Displays the current counter value

6.8 Input Debouncing
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To configure Input Debouncing, click the Advanced... button on the
Exposure/GPIO tab in the Camera Configuration dialog box and open the
Device Features tab.

The Debouncers tab is used to configure the debouncers of the camera. The
debouncers are associated with the first and second PHYSICAL inputs of
QuickCam, usually Input 1 and Input 2.

The debouncers make sure that their corresponding inputs filter out bouncing
effects. Bouncing is when there are a few very short pulses when the input signal
transitions from low to high. Without debouncing, QuickCam may see these
small pulses as real signals.

The debouncers make sure that the signal is truly high for the specified amount
of time before it is declared as high. The same applies to the falling edge.

Input 0 Value

Indicates the debouncing value for input 0. Each unit is equal to 16 clock cycles
(30ns each), or 480ns.

Input 1 Value

Indicates the debouncing value for input 1. Each unit is equal to 16 clock cycles
(30ns each), or 480ns.

Input 2 Value

Indicates the debouncing value for input 2. Each unit is equal to 16 clock cycles
(30ns each), or 480ns.

Input 3 Value

Indicates the debouncing value for input 3. Each unit is equal to 16 clock cycles
(30ns each), or 480ns.
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Configuration - Advanced E|

GPIO ControlBits |  Port Communication | TapRecorsbucion | FGBFiter |
Image Seltings | Picel Type | GrabberSetlings | GrabberFeatues  Device Fealses
+ Flow Control
+ Pulse Generator 0
+ Pulse Generator 1
+ Pulse Generator 2
+ Pulse Generator 3
* Rescaler 0
+ Delayer 0
+ Counter D
+ GPIO Look-Up Table
= Input Debouncing

Ingast 0

Input 1

Input 2

Inpat 3
+  GPID Configuration
+ Timestamp Counter
* GPIO Interrupts

o o o O

Mo Item Selected
Selact an [bem Lo sae s description of right-chck its label for more aptions,

¥ Show advanced configurstion pages [ oK | Close | Apply |
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6.9 GPIO Control Bits
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The GPIO Control Bits tab is used to read and change the values of the GPIO
Control Bits of QuickCam. The QuickCam protocol and the SDK functions
permit up to 16 GPIO Control Bits, but only 4 are used at the moment.

Note that this panel is not meant to be a real-time display of the control bits. The

panel uses an internal timer that reads the actual values from QuickCam.
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Configuration - Advanced

Image Settings | Poel Type | Grabber Settings | Grabber Features | Device Featues |

GPIO ContolBt: | - Pod Commurication | TapReconsiuction | AGB Fter |
Rlead
012345678 93ABCDEF
o T )y o O ol ol ol ol sl el ol el ol o il el ' il ol
GPOConolBis FFFFFFFCFFFFFEEEE
wite
GPIOContdlBRs FF T FCFrrrrrErrerr
™ Broadcast

l Ok | Close Apply

¥ Show advanced conhguration pages

Broadcast

When this is enabled, the command to set or clear a GPIO will be broadcast to all
cameras on the same network as the currently selected camera.

GPIO Control Bits (Write)
These check boxes allow the values of the GPIO Control Bits to be modified.

GPIO Control Bits (Read)

These read-only check boxes represent the actual value that is set on the
software-controlled GPIO Control Bits.

GPIO Input Values

These read-only check boxes represent the actual values from the GPIO
connector in GPIO Inputs 1, 2, 3, and 4. Refer to Configuring the GPIO Pinout
for details on how to set the GPIO actual values.
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6.10 GPIO Configuration

Input 0 Configuration

Function selection of Input 0

Input 1 Configuration

Function selection of Input 1

Input 2 Configuration

Function selection of Input 2

Input 3 Configuration

Function selection of Input 3

Output 0 Configuration

Function selection of Output 0

Output 1 Configuration

Function selection of Output 1

Output 2 Configuration

Function selection of Output 2

Output 3 Configuration

Function selection of Output 3

GPIO Synchronization

Synchronizes GPIO inputs using either 2 flip flops or 1 flip flop. Using one flip
flop may cause synchronization glitches, so it is recommended that you use two
flip flops.

CC1 Configuration

Function selection of the Camera Control Signal 1

CC2 Configuration

Function selection of the Camera Control Signal 2

CC3 Configuration

Function selection of the Camera Control Signal 3

CC4 Configuration
Function selection of the Camera Control Signal 4

To configure the Timestamp Counter, click the Advanced... button on the
Exposure/GPIO tab in the Camera Configuration dialog box and open the
Device Features tab.
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6.11 Timestamp Counter
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Counter Select

Timestamp Counter (default), General Purpose Counter

Granularity

Indicates the value of each timestamp unit of the timestamp counter. Available
values are:480 nanoseconds, 1 microsecond, 100 microseconds, 10 milliseconds

Set Mode

Indicates how the timestamp module handles the “set event”. Possible values
are:

Disabled
On Apply-The specified value is set when the user clicks the Apply button.

Rising edge input signal-When the signal on the “set event” input rises, the
timestamp module applies the specified value

Set Input

Indicates which label from the GPIO LUT that is associated with the “set event”
input of the timestamp module. Make sure you select an input label that is not
being used for its default behavior. The possible values are:

e 0:Q3
o 1:Q7
e 2:08
o 3:Q9
e 4:Q10
e 50Ql1
o 6:Q16
e 7:Q17
Clear Mode

Indicates how the timestamp module handles the “clear event”. The possible
values are:

Disabled

On Apply: The timestamp count is cleared when the user clicks the Apply button

Rising edge input signal: Then the signal on the clear event input rises, the
timestamp module clears the timestamp counter value

Clear Input

Indicates which label from the GPIO LUT that is associated with the “clear
event” input of the timestamp module. Make sure you select an input that is not
being used for its default behavior. The possible values are:

e 0:Q3
e 1:Q7
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o 2:Q8
e 3:Q9
e 4:Q10
e 50Ql1
o 6:Q16
e 7:Q17
Broadcast

When set to true, the operation is broadcasted to all other devices on the same
network as the current device.

Set Value

The value assigned is used when the “set event” of the counter occurs.

Current Value

Displays the timestamp counter’s current value

6.12 GPIO Interrupts

You can disable or enable the following interrupts:

Q15 Enabled
Enable or disable interrupts on the Q15 output of the GPIO LUT

Q3 Enabled
Enable or disable interrupts on the Q3 output of the GPIO LUT

Q7 Enabled
Enable or disable interrupts on the Q7 output of the GPIO LUT

Q10 Enabled
Enable or disable interrupts on the Q10 output of the GPIO LUT

6.13 Delayer
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The delayer is used to delay an input signal. The output of the delayer is the
delayed version of the input signal. A delayer is defined by:

e Delay: The delay is a value expressed in the number of rising edges from
the reference signal.

e Reference Signal: A periodic input signal that is used to generate the delay
from the input source. It is important that this reference signal be periodic.
Also note that the pulse width of the signal you want to delay must be
greater than the period of the reference signal.
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e Input Source Selection: The delayer does not have a pre-assigned label in
the GPIO Look-Up Table (Qn). This parameter is used to select a label that
is not used by another GPIO module.

The output of the delayer is considered an input for the GPIO Look-Up Table.

The labels for the output from the delayer in the GPIO Control Block
programming languages depend on the LUT input configuration.
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Performing Image

Processing

1.1 Processing Chain Description

The following diagram shows a simplified block diagram of the camera’s analog
and digital processing chain. The analog processing chain begins with an analog
gain adjustment, followed by an analog offset adjustment. These adjustments are
applied to the video analog signal prior to its digitization by an A/D converter.

03-032-10187-03

The digital processing chain contains the FPN correction, the PRNU correction,
the background subtract, and the digital gain and offset.

All of these elements can be set on the Image Processing tab of the Spyder3 GigE

Camera Control application.

Figure 1: Analog and Digital Processing Chain

Analog Processing

Digital Processing

= — = D°D - D.D D°D D‘D -l = -]
analog video I i I I I I digital video
analog analog o PRNU background digital
gain offset \coefficients subtract gain
E digital

%

application.

! coefficients

FPN

offset

All of these elements can be set on the Calibration tab of the QuickCam
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Analog Processing

Optimizing offset performance and gain in the analog domain allows you to
achieve a better signal-to-noise ratio and dynamic range than you would achieve
by trying to optimize the offset in the digital domain. As a result, perform all
analog adjustments prior to any digital adjustments.

1. Analog gain is multiplied by the analog signal to increase the signal strength
before the A/D conversion. It is used to take advantage of the full dynamic
range of the A/D converter. For example, in a low light situation the
brightest part of the image may be consistently coming in at only 50% of the
DN. An analog gain of 6 dB (2x) will ensure full use of the dynamic range of
the A/D converter. Of course the noise is also increased.

2. The analog offset or black level is an "artificial" offset introduced into the
video path to ensure that the A/D is functioning properly. The analog offset
should be set so that it is at least 3 times the rms noise value at the current
gain.

Digital Processing

To optimize camera performance, digital signal processing should be completed
after any analog adjustments.

1. Fixed pattern noise (FPN) calibration is used to subtract away individual
pixel dark current.

2. The digital offset enables the subtraction of the "artificial" A/D offset (the
analog offset) so that application of the PRNU coefficient doesn’t result in
artifacts at low light levels due to the offset value.

3. Photo-Response Non-Uniformity (PRNU) coefficients are used to correct the
difference in responsivity of individual pixels (i.e. given the same amount of
light different pixels will charge up at different rates) and the change in light
intensity across the image either because of the light source or due to optical
aberrations (e.g. there many be more light in the center of the image). PRNU
coefficients are multipliers and are defined to be of a value greater than or
equal to 1. This ensures that all pixels will saturate together. When using
PRNU correction, it is important that the A/D offset and Fixed Pattern Noise
(FPN) or per pixel offsets are subtracted prior to the multiplication by the
PRNU coefficient. The subtraction of these 2 components ensure that the
video supplied to the PRNU multiplier is nominally zero and zero
multiplied by anything is still zero resulting in no PRNU coefficient induced
FPN. If the offset is not subtracted from the video then there will be artifacts
in the video at low light caused by the multiplication of the offset value by
the PRNU coefficients.

4. Background subtract and digital gain are used to increase image contrast
after FPN and PRNU calibration. It is useful for systems that process 8-bit
data but want to take advantage of the camera’s 12-bit digital processing
chain. For example, if you find that your image is consistently between 128
and 255DN(8-bit), you can subtract off 128 and then multiply by 2 (by setting
the digital gain to 8192) to get an output range from 0 to 255.
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1.2 Setting a Region of Interest

The region of interest is your desired calibration region. The region of interest
determines the pixel range used when calibrating gains, offsets and pixel
coefficients.

In most applications, the field of view exceeds the required object size and these
extraneous areas can be ignored. It is recommended that you set the region of
interest a few pixels inside the actual useable image.

To set the camera’s region of interest:

1. Open the Calibration tab in the Camera Configuration Window.
Under Region of Interest:
Enter the region of interest to use in the X1 and X2 text boxes.
Click Apply.

4. To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

7.3 Viewing a Region of Interest

You can view the region of interest in the Image Output Window.
To view the region of interest:

1. If the camera is currently grabbing images, stop grabbing images by clicking
the Q}‘ button on the toolbar.

2. Open the Calibration tab in the Camera Configuration window.
Under Region of Interest:
Enter the region of interest to use in the X1 and X2 text boxes.
Click Apply.

5. On the QuickCam toolbar, click the d to view the area defined by the
region of interest.

The line disappears when you begin imaging again.

7.4 Performing Flat Field Correction
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The QuickCam application has the ability to calculate correction coefficients in
order to remove non-uniformity in the image. This video correction operates on a
pixel-by-pixel basis and implements a two point correction for each pixel. This
correction can reduce or eliminate image distortion caused by the following
factors:

® Fixed Pattern Noise (FPN)
®  Photo Response Non Uniformity (PRNU)

® Lens and light source non-uniformity

DALSA corp.



QuickCam User's Manual

The QuickCam application allows you to perform flat field correction easily
using the Flat Field Correction Wizard. The wizard steps you through the entire
flat field process including setting gains and offsets, as well as calibrating pixel
coefficients.

To perform flat field correction:
1. Open the Calibration tab in the Camera Configuration Window.

2. Click the Flat Field Correction Wizard... button to invoke the correction
wizard.

3. Follow the on-screen instructions.

Toolbar equivalent:

7.5 Adjusting Analog Gain and Offset
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If you are performing flat field correction, you should adjust the analog
gain and offset using the Flat Field Correction Wizard. See Performing
Flat Field Correction for details.

L]

If necessary, you can set the analog gain and offset separately from other
processes. Refer to the Processing Chain Description for an explanation on why
you would want to use these commands.

To adjust the analog gain:
1. Open the Calibration tab in the Camera Configuration Window.

2. Beside Taps to Calibrate, select the tap number to adjust, either Tap 1, Tap
2, or All Taps.

3. Enter the analog gain value(s) in decibels in the Analog Gain (dB) text box
or

Click the Auto Calibration... button to invoke the analog gain calibration
wizard.

4. To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

To adijust the analog offset:
1. Open the Calibration tab in the Camera Configuration Window.

2. Beside Taps to Calibrate, select the tap number to adjust, either Tap 1, Tap
2, or All Taps.

3. Enter the analog gain value(s) to use in the Analog Offset (DN) text box
or

Click the Auto Calibration... button to invoke the analog offset calibration
wizard.

4. To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.
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7.6 Adjusting Digital Gain, Offset, and
Background Subtract

P

If you are performing flat field correction, you should adjust digital
settings using the Flat Field Correction Wizard. See Performing Flat Field

Correction for details.

If necessary, you can set the digital gain, offset, or background separately from
other processes. Refer to the Processing Chain Description for an explanation on
why you would want to use these commands.

To adijust the digital gain:

1.
2.

Open the Calibration tab in the Camera Configuration Window.

Beside Taps to Calibrate, select the tap number to adjust, either Tap 1, Tap
2, or All Taps.

Type the value or use the slider to enter the digital gain value to use in the
Digital Gain (DN) text box.

To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

To adjust the analog offset:

1.
2.

Open the Calibration tab in the Camera Configuration Window.

Beside Taps to Calibrate, select the tap number to adjust, either Tap 1, Tap 2,
or All Taps.

Type the value or use the slider to enter the desired digital offset value to use
in the Digital Offset (DN) text box.

To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

To adjust the background subtract:

1.
2.

Open the Calibration tab in the Camera Configuration Window.

Beside Taps to Calibrate, select the tap number to adjust, either Tap 1, Tap
2, or All Taps.

Type the value or use the slider to enter the desired background subtract
value to use in the Background Subtraction(DN) text box.

To save the settings to the camera’s nonvolatile memory, click Save Camera
Settings.

1.7 Enabling and Disabling Coefficients

You can enable or disable FPN and PRNU coefficients.

To enable or disable FPN and PRNU coefficients:

1.

03-032-10187-04

Open the Calibration tab in the Camera Configuration Window.
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Under Pixel Coefficients:

Beside FPN Coefficients, check the checkbox to enable coefficients or
uncheck the checkbox to disable coefficients.

Click Apply.

Beside PRNU Coefficients, check the checkbox to enable coefficients or
uncheck the checkbox to disable coefficients.

Click Apply.

To save the pixel coefficients to the camera’s non-volatile memory, open the
Save/Restore in the Camera Configuration Window.

Under Pixel Coefficients:

Select the pixel coefficient set number from the Set Number drop down box.
You can save or load up to four different sets of pixel coefficients.

Click Save.

7.8 Setting Individual Pixel Coefficients

To set an individual pixel’s FPN and PRNU coefficient:

1.

Open the Calibration tab in the Camera Configuration Window.
Under Pixel Coefficients:
Beside FPN Coefficients, enter the pixel number to set.

Enter the FPN coefficients to use in DN in the FPN Coefficient (DN) text
box.

Click Apply.
Beside PRNU Coefficients, enter the pixel number to set.

Enter the PRNU coefficients to use in DN in the PRNU Coefficients (DN)
text box.

Click Apply.

To save the pixel coefficients to the camera’s non-volatile memory, open the
Save/Restore tab in the Camera Configuration Window.

Under Pixel Coefficients:

Select the pixel coefficient set number from the Set Number drop down box.
You can save or load up to four different sets of pixel coefficients.

10. Click Save.

7.9 Using Calibration Macros
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Recording a Camera Calibration Macro

You can record a camera calibration macro to record a sequence of calibration
actions. You can then reload the macro at a later time to repeat the sequence of
actions.

To record a macro:

DALSA corp.



57

03-032-10187-04

QuickCam User's Manul

On the toolbar, click J

2. Perform the actions you want to include in the macro.

I o
Note: You can pause the recording at anytime by clicking the Q To
resume recording, click the pause button again.

To stop recording your macro, click J .

4. In the File name box, type a name for the macro. It is recommended that
you save the macro in the default location and use the default extension of

.sCp.

In the Save in box, browse to the location where you want to save the macro.

Click Save.

Loading a Camera Calibration Macro

You can load a previously recorded camera calibration macro at a later time to
repeat the sequence of actions.

To load a macro:

1. On the toolbar, click Lj
In the Open dialog box:

2. Inthe Look in list, click the drive, folder, or Internet location that contains
the file you want to open.

In the folder list, locate and open the folder that contains the file.
Click the file, and then click Open.
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Troubleshooting

8.1 Troubleshooting: Cannot Detect the

Camera

e  Verify that the camera is powered on and the LED is lit correctly. Refer to
your camera’s user’s manual for details on power settings and LED states.

e  Verify that your camera has all the correct connections. Refer to your
camera’s user’s manual for cabling details.

e Verify that your driver is installed properly. To install drivers, follow the
procedure described in DALSA QuickCam=>Documentation>DALSA
Driver Installation Tool Manual.pdf.

¢  Your Windows Firewall or Personal Firewall may be filtering out packets
sent by the camera. Try turning off the firewall.

e Check that your network adapter is enabled.

¢  Your network adapter may not have an IP address. Typically, when a
system is not connected to a network with a DHCP server, the network
interfaces assign an address to themselves in the form of 169.254. XXX.YYY.
This is called a zeroconf (or autoconf) IP address. For the PC to
detect/communicate with the IP engine, it must reside in the same sub-
network as the IP engine. Moreover, the Windows Firewall will discard
packets from "unknown" sources, and the IP engine will not show up in
your detection window. You may also want to set up a static IP address on
that network adapter, such as 192.168.2.1, so that you always know what it
is.

8.2 High Performance Driver is Missing In
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Device Manager

Symptom: The software was installed, but | don’t see a “Pro/1000 Grabber Devices” in
the Device Manager.

Scenario #1: You do not have an Intel Pro/1000 network adapter installed on the
PC.
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Solution: Install an Intel Pro/1000 network adapter and follow the High
Performance Driver installation procedure described in DALSA
QuickCam->Documentation>DALSA Driver Installation Tool Manual.pdf.

Scenario #2: You have not installed the Pro/1000 Grabber Device driver on the
Intel Pro/1000 adapter, in lieu of the Intel driver.

Solution: Uninstall the Intel Pro/1000 network driver from the adapter and
follow the High Performance Driver installation procedure described in DALSA
QuickCam->Documentation>DALSA Driver Installation Tool Manual.pdf.

Scenario #3: Windows does not allow you to choose which driver to install; it just
automatically picks the regular Intel Pro/1000 driver.

Solution: Use the Driver Installation Tool to install your preferred driver.
Alternately, for manual driver installation, follow the instructions from

http:/ /support.microsoft.com/ ?scid=kb;en-us;306584

to remove the Intel Pro/1000 Network driver from your PC, and then follow the
Pro/1000 Grabber Device driver installation procedure described in DALSA
QuickCam=>Documentation>DALSA Driver Installation Tool Manual.pdf.

8.3 My Frame Rate is Lower than Expected

Possible Cause#1: Your network adapter is configured to run at 10/100 Mb/s
instead of 1 Gb/s.

Solution: Verify the network adapter settings to ensure it is set to operate at 1
Gb/s.

Possible Cause #2: Your network is not properly wired.

Solution #1: Check your cable wiring for conformance with the EIA/TIA 568A or
568B wiring diagrams.

Solution #2: Check the length and type of your cable. For GigE speeds, cable
spans cannot exceed 100 meters, and cables must conform to the Cat5e cable
specification.

8.4 Troubleshooting: Creating an Error
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Report

You can create an error report in order to review test patterns, settings, and all
messages sent from the camera. This is useful for your own information as well
as when you have to contact Product Support.

Fro To view the test and video images, you require QuickTime. To download
" L) QuickTime, go to http:/ /www.apple.com/quicktime/download/win.html

To create an error report

-
1. Click the ‘—J

In the Save As dialog box:

button on QuickCam toolbar.

2. Select the location on your computer to save the file.
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3. In the File name text box, enter a name for the error report.
4. Click Save.

After QuickCam creates and saves the error report, the error report is displayed
on-screen.

Example Error Report

QuickCam Error Report

Veu meed ChockTune to view the test pattern and video unages. If vou cannot view these unages, please
dowgload ChuckTime

12 Eit Test Pattern Iinage 8 Hit Test Pattein

Ethernet Test Pamtern Video Iinnge
Log File Retrings File
A A
<Twiml wersion="1.0" 1> «Turnl vierssan="1.0" entading="UTF=8" T>
<lags cCamera_nterface_Apphcation
cHistory t5="14:15:32 worgion="2,2">
0 /29 /06" > 5tart Enumarate ccamera name="" type="Standard
Camaras...</Hstorns CameralLink CamEra” mac="00-
sHstory te="14:15:35 11-1C-FO-00-4E">
0l /29,06 Found Camara cConnectivity > £

8.5 Troubleshooting: Switching Between
Video and Test Patterns

You can generate a test pattern to aid in system debugging. The camera test
patterns are useful for verifying camera timing and connections. The Ethernet
test patterns are useful for testing your Ethernet connection.

To set the camera’s video mode:

1. Open the Diagnostics tab in the Camera Configuration Window.
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Under Test Pattern:

2. Select the video mode to use from the list in the Camera dropdown box or
the Ethernet dropdown box.

8.6 Troubleshooting: Using the Diagnostics
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Tab

Communications and Verify Parameters

To quickly verify serial communications, check the Diagnostics tab.
Communication is working properly if the camera settings are properly
displayed in the Camera Settings section.

Verify Voltage

To check the camera’s input voltage, refer to the Temperature/Voltage section on
the Diagnostics tab. If it is within the proper range, the camera returns OK> and
the voltage value. Otherwise the camera returns an error message.

Verify Temperature

To check the internal temperature of the camera, refer to the
Temperature/Voltage section on the Diagnostics tab. The camera will shut itself
down if the internal temperature exceeds 75°C.

Verify Signal Frequency

To verify the signal frequency, refer to the Signal Frequency section on the
Diagnostics tab. Use the drop down list to select the control signal and review
the signal frequency. The control signals available for measuring are: CC1
(EXSYNC), CC2 (PRIN), CC3 (CCD Direction), and CC4 (Spare).
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Appendix A

Workspace Tour

QuickCam Application Windows
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When you first launch QuickCam, the application window opens with the
following default windows. You can move and resize these windows as desired.
To toggle between displaying and hiding a window, Click Window > Window

Name.

Camera Configuration Window

The Camera Configuration Window contains all of the tabs for controlling the

camera.

Figure 2: Camera Configuration Window showing the Calibration Tab

Connection] Fleadoutl Exposure/GPI0  Calibration ] Diagnostics] Save#ﬂestnre]

Region OF Interest
=1 |1 Ha |1|324 Apply | Flat Field Conrection Wizard ... ‘

Analag and Digital Settings

Taps ToCalbrate: & Tap1 ¢ Tap2 O Al Taps Update Gain Reference |

Analog Gain[dBL: [ 0.0 —— At Calibrate. .

Analog Offset(DN]: {ag 20 — At Calibrate. .
Dighal Dffs2tDNE o o f———

Backgound Lt

Subtraction[DM]: |0 0
Digital GainDN): (4095 [s096  ~ b |:|

FPM ahd PRMNU Coefficients
Enabled  Pixel Mumber alue(DM]

FPH Coefficients: r |17 ,_ 4
FPRMU Cosfficients: r |1— ’_ 4

Save Camera Settings

Help |
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The Connection tab contains all of the functions for controlling camera
connections and acquisition control.

Command | Purpose Reference
Page Number
Detect Detects all cameras currently connected. 8
Start Begins the process of acquiring images. 9
Button text changes to Stop during image
acquisition and allows you to stop acquiring
images.
Bad images When selected, allows “bad” images (images
passthrough | containing missing lines or pixels) to be
transmitted as good images.
181.101."3 When selected, missing packets will not be
Missing requested. The resulting image may be
Packets incomplete.
Disconnect Disconnects the camera currently selected in | 9
the Camera Detection window.
Reset Camera | Reboots camera. After reboot, the camera 9

operates using the last saved user settings.

Status

Displays the camera’s current connection
status.

Name

Displays and sets the current camera’s
name.

Model No.

Displays the model number of the currently
selected camera. This information is useful if
you require product support.

Serial No.

Displays the serial number of the currently
active camera.

Width

Displays and sets the number of columns
being imaged in the Image Output window.
This is not selectable in a line scan camera.

Height

Displays and sets the number of lines being
imaged in the Image Output window.

Display Rate

Shows the current rate of display in frames
per second. The display rate is a cumulative
display from the time the Start button was
last pressed, rather than a current dynamic
acquisition rate.

Grabbing

Displays the current image acquisition rate
in frames per second. The display rate is a
cumulative display from the time the Start
button was last pressed, rather than a
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current dynamic acquisition rate.
Status Displays the number of acquired images as
well as the number of bad images. A large
number of bad images is indicative of a set-
up or cable problem.
Last Error Displays the last error that occurred while
acquiring images.
Readout Tab
The readout tab sets the sensor’s readout configuration.
Command Purpose Reference
Page
Number
Sensitivity Mode | Displays and sets the camera’s sensitivity 17
mode.
Bit Depth Displays and sets the camera’s bit depth. 18
Direction Displays and sets the camera’s CCD shift 18
direction.
H.ori.zontal Displays and sets the camera’s horizontal 18
Binning binning value.
Savg User Saves the current settings to the camera’s 10
Settings non-volatile memory.
Exposure/GPIO Tab

The Exposure/GPIO tab configures the camera’s exposure mode and settings. It
also configures the GPIO inputs and outputs.

Command Purpose Reference
Page
Number
Exposure Mode | Displays and sets the camera’s exposure 21
mode.
Line Rate (Hz) Displays and sets the camera’s line rate in 22
Hertz.
Exposure Time Displays and sets the camera’s exposure 22
(ns) time in microseconds.
Advanced... Opens the Configuration Dialog box 23
allowing you to configure how the camera
handles and redirects its internal and
external signals through the GPIO
connector.
Input and Configure the physical pins and signals
Output types to use for GPIO control.
dropdowns
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Save Camera
Settings

Saves the current settings to the camera’s
non-volatile memory.

10
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Calibration Tab

The Calibration tab controls all of the camera’s analog and digital settings.

Command

Purpose

Reference
Page
Number

Region of Interest

Displays and sets the camera’s region of
interest.

53

X1

Sets the region of interest’s starting
pixel value.

53

X2

Sets the region of interest’s ending pixel
value.

53

Apply

Applies the region of interest specified
in X1 and X2 to the image.

53

Flat Field Correction
Wizard...

Invokes the Flat Field Correction
Wizard. When used, the camera
calculates appropriate analog and
digital settings, as well as, appropriate
FPN and PRNU coefficients.

53

Update Gain
Reference

Sets the current analog gain value to be
the nominal gain setting.

Taps to Calibrate

Sets which taps to calibrate when
performing an analog or digital
adjustment.

54

Analog Gain (dB)

Displays and sets the camera’s analog
gain value in decibels. You can enter the
value directly or use the scroll bar to
choose the gain setting.

54

Analog Offset (DN)

Displays and sets the camera’s analog
offset value in digital numbers. You can
enter the value directly or use the scroll
bar to choose the offset setting.

54

Auto Calibrate...

Invokes the Auto Calibration wizard.
When used, the camera calculates
appropriate analog settings.

54

Digital Offset (DN)

Displays and sets the camera’s digital
offset in digital numbers. You can enter
the value directly or use the scroll bar to
choose the gain setting.

55

Background Subtract
(DN)

Displays and sets the camera’s
background subtract value in digital
numbers.

55

Digital Gain (DN)

Displays and sets the camera’s digital
gain in digital numbers. You can enter
the value directly or use the scroll bar to

55

68

DALSA corp.



69

03-032-10187-04

QuickCam User's Manul

choose the gain setting.

Enabled Enables or disables PRNU coefficients. 55
Pixel Number The pixel number to set. 56
Coefficient Value Sets the PRNU coefficient for the pixel 56
(DN) specified in the Pixel Number field.
Apply Applies the PRNU coefficient to the 56
image output.
Save Camera Settings | Saves the current settings to the 10
camera’s non-volatile memory.
Diagnostics Tab
Command Purpose Reference
Page
Number
Temperature/Voltage | Displays the camera’s last measured 62
temperature and voltage.
Test Pattern Selects the test pattern to view. 61
Camera Settings Displays the camera’s current settings. | 62
IP Information Displays the camera’s IP information. 62
Timeouts and Packets | Displays timeout and packet 62
information.
Pixel Coefficients Displays the pixel coefficients for the 62
coefficient set selected from the
dropdown list.
Signal Frequency Displays the signal frequency for the 62
camera control signal selected from the
dropdown list.
Refresh Settings Refreshes the Diagnostics tab and 62
displays the latest camera settings.
Save/Restore Tab
Command Purpose Reference
Page
Number
Save to Saves the current user settings to the camera’s | 10
Camera non-volatile memory. On reboot, the camera
operates using the last saved user settings.
(User Settings) | Returns the current camera operating 11
Restore from conditions to the last saved user settings.
Camera
(FaC.tOTY Returns the current camera operating 11
Settings) conditions to the camera’s factory settings.
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Restore from

Camera

Set Number Selects the pixel coefficient set to load, save, or | 12
reset.

Load When clicked, loads the pixel coefficient set 12
displayed in the Set Number dropdown box.

Save When clicked, saves the current pixel 12
coefficients to the pixel coefficient set
displayed in the Set Number dropdown box.

Reset When clicked, returns the pixel coefficient set 12
displayed in the Set Number dropdown box to
zero.

Frames to Save | Gets the number of frames to save to file. It is Error!
enabled only when image acquisition is Bookmark

continuous and you are not using the Image
Output Window.

not defined.

Save As

Invokes the Save As dialog box, allowing you
to name the frames.

Error!
Bookmark

not defined.
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Image Output Window

The Camera Output Window displays the camera’s image output. You can move
the Camera Output Window anywhere within the program window.

Figure 3: Image Output Window displaying 8 Bit Test Pattern

Message Window

The Message Window provides camera feedback in the following forms:

Command Purpose

Message Provides a list of all command responses from the camera to
the Spyder3 GigE Camera Control application.

History Provides a list of all camera messages.

Command Provides a list of all commands sent to the camera. You can
also send ASCII commands through the Command window.
Refer to your camera’s user’s manual for a list of the available
ASCII commands.

Error/Warning | Provides a list of all error or warning messages sent from the
camera to the Spyder3 GigE Camera Control application.

Network Device Finder
The Network Device Finder Window displays all | confioure [

detected cameras on the same sub-network. Language 4
Serial Port Link 4

Time-outs & Packets. ..
Advanced GPIO..,

Adyanced Conneckion...
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1. To display the Network Device Finder, choose Configure-> Advanced

Connection.

Figure 4: Network Device Finder

#- Network Device Finder ﬂﬂ

EI‘ Device (00-11-1C-FO-DE-DD) with IP address [192.168.2.16]
E High-Performance Driver [00:07:E9:0B.0F-AE]

Device Information  Version 3.62, Device 11, Module 21.0, Vendor 16, Unicast mode

Timeout fms) |100 v Show all devices

Find | ok | Cancel

Camera Display Window

The Camera Display window lists all of the detected cameras on the network.
You can also load macros, XML files, acquired images, and other associated files
for the currently connected camera.

You can also connect to any camera listed in the Camera Display window by
double clicking on the camera name.

Note: deleting images from the Camera Display Window only removes them
from this list and will not delete them from where they are stored.

Camera Display Window x

[=- &8 Cameras

[0 #mML Files

[ Images
-] Error Reports
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Time-outs &

Use Configure > Advanced Ethernet to open the Time-outs & Packets dialog

Packets Dialog Box

box.
Time-outs & Packets E|

Time-outs & Packsts

Command Retries E

Answer Timeouk | 1000 ms
First Packet Timeout | n ms
Packet Timeout | 5an s
Request Timeout | 5000 ms

Packet Size

Calculake kmeaouts

| 1440 —

- | Reskore Default |

Cancel |

QuickCam User's Manul

Command

Purpose

Command Retries

Indicates the maximum number of retries to perform
when a command is sent from the PC to camera. A
command consists of a single command packet from the
PC and an acknowledge packet from the camera. If
either of these packets is lost, the behavior of QuickCam
remains the same because it does not receive the
acknowledge packet. Before issuing a time out error,
however, the software will resend the command packet.
The value of this parameter indicates the maximum
number of tries (including the original command) that
the underlying communication layer will attempt.

Answer Timeout

Indicates the maximum time, in milliseconds, that the
camera can take to respond to a command from
QuickCam.

First Packet
Timeout

Indicates the maximum time, in milliseconds, that the
camera can take to send the first packet of image data to
the application. When it is zero, the timeout is
calculated automatically from the request timeout.

Packet Timeout

Indicates the maximum time, in milliseconds, the
camera can take to send subsequent packets of image
data to QuickCam. When it is zero, the timeout is
calculated automatically from the request timeout.

Request Timeout

Indicates the maximum time, in milliseconds, the
camera can take to send all the packets of image data to
QuickCam.
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Packet Size Indicates the maximum packet size, in bytes, that the
camera can use to send image data to the application.
When connected point-to-point with the QuickCam
High Performance Driver, the maximum value is 8128
bytes. In networked applications, the value depends on
the maximum packet size that can be accepted by the
switches between the camera and the host PC. If the
switches can be configured to support jumbo packets, it
is recommended to use the jumbo packet configuration
to reduce packet overhead in the application. A packet
size of 1440 bytes will work with all networking
equipment.

Calculate Timeouts | Inyokes the Timeout Calculator dialog box, which
provides estimates of timeouts to use, based on image
size, link type, the maximum total request time, and
packet size.

Restore Default Restores default values from factory configuration.

Virtual Serial Port

Use Configure->Serial Port Link->Enable/Disable to enable or disable the
virtual serial port.

Some camera control tools can connect only to a Windows system serial port. To
avoid asking for changes from camera manufacturers, two serial COM ports in
the PC can be linked together to share the serial channel to the IP engine.
Through their linkage, data written to one port can be read by the other port, and
vice-versa.

These linked serial COM ports can be either "virtual" or physical. To set up
virtual ports, use a virtual serial port driver. Some good virtual serial port
drivers are available at: http:/ /www.softinfinity.com/ or http:/ /www.virtual-

serial-port.com/.

Alternatively, if a PC has two free physical serial ports, they can be connected
together and used as a pair, in the same manner as a virtual serial port driver.

The Serial Port Configuration dialog box allows you to attach the serial channel
in QuickCam to one port in a serial port pair, whether a physical pair or virtual
pair. Therefore, an external application needs simply to connect to the other
serial port of the pair to communicate with the camera.

Note that while the virtual serial port is enabled, not all GUI controls will be
available. This is because the camera expects to take commands through the
virtual serial interface instead of the GUI. To regain use of all GUI controls,
disable the virtual serial port.
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Serial Port Configuration

Parity:

Device Serial Port Canfiguration

Baud Rate: [57600 = | FBits: |& -

System Serial Port Configuration

COM Porks | COM L -

%)

Cancel
Mone | 3Stopi|il -

QuickCam User's Manul

Command | Purpose

Baud Rate Specifies the speed of the serial communication between
the COM port and the camera. Default: 57600.

Bits Specifies the data size for the COM port.

Parity Specifies the parity of the serial communication between the
COM port and the camera. Can be set at "None," "Odd," or
"Even."

Stop Specifies the number of stop bits for the COM port.

COM Port

Specifies which serial COM port to monitor for activity.
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Menus

Menu Bar Commands

File Menu Commands

Load XML File ... Opens the selected camera settings script file.

Save XML File ... Saves the current camera settings to a script file
under the selected name and location.

Load Macro... Load the selected camera macro file.

Save Log File... Saves the current camera log file under the
selected name and location. The log file contains
arecord of all camera activity, including camera
messages, camera settings, and a history of
commands sent to the camera.

Load Image Output Opens the selected image file in the Image

Output Winow.

Save Image Output

Saves the contents of the Image Output Window
as a single TIFF file to the selected location.

Save Image Frame(s)

Saves the number frames indicated in the Frames
to Save dialog box in TIFF format to the selected
location.

Exit

Closes the program.

Configure Menu Commands

Language Changes the interface language. Currently, English is the
only supported language.
Serial Port Link Enable

Invokes the Serial Port Configuration dialog
box.

Disable

Disables serial port configuration.

Time-outs & Packets...

Invokes the Time-outs & Packets dialog box.

Advanced GPIO...

Invokes the Configuration dialog box.

Advanced Connection...

Invokes the Network Device Finder dialog

03-032-10187-04
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Camera Settings

Displays all camera settings in text format.

Pixel Coefficients |Displays all pixel coefficients in text format.

Error Report

Opens the selected error report.

Get Line(s)s

Displays average pixel values for selected number of lines and
calculates line statistics, including Min, Max, and Mean values
for the sample and for each sensor tap.

Window Menu Commands

Camera Display Window

Opens or hides the Camera Display Window.

Camera Configuration Window

Opens or hides the Camera Configuration

Window.

Camera Output Window

Opens or hides the Camera Output Window.

Message Window Opens or hides the Message Window
Tool Bar Displays or hides the tool bar buttons.
Clear Message Window
All Clear the output on all
message tabs.
History Clear the output on the
History tab.
Commands Clear the output on the
Commands tab.
Message Clear the output on the
Message tab.
Error/Warning  [Clear the output on the
Error/Warning tab.

Restore Default Window Setting

Returns window displays to default state.

Help Menu Commands

DALSA QuickCam Help

F1

leads to the "Help Topics" window
that contains the Contents, Index,
and Find tabs.

Error Report

Generates an error report.

Contact Us Displays contact information for
Product Support, Sales, or
Technical Communication.

About Displays the About dialog box,

with registration and copyright
information.
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Open an XML camera settings file
Save current settings to an XML script file
Save current settings to camera’s non-volatile

memory

Detects all camera’s currently connected to the
network

Connect or connect currently selected camera

Reboot currently selected camera

Invoke the flat field correction wizard

Begin recording a camera settings macro

Load camera settings macro

Stop recording camera settings macro

Pause camera settings macro

Start continuous image grab

Snap a single image

Display the current region of interest.

Fit image to window

View image actual size

Zoom in on image

Zoom out of image

78
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Index

A

Acquiring Images 9

Acquisition See Image
Acquisition

Analog 54
Gain 54
Offset 54
Processing 52

B

Background Subtract 55

Binning 18

Bit Depth 18

C

Camera Configuration

Window 64
Camera Display Window
72

Camera Settings Maco See
Macro
Cannot Detect the Camera
9,59
CCD Shift Direction 18
Coefficients

Disabling 12,55
Enabling 12,55
Individual 56
COM port 74
Configure Ethernet dialog
box 73
Control Bits 45
Counter 42
Creating an Error Report
60
Customer Support 5
D
Default Settings 11
Detect 9,59
Detecting a Camera 8
Diagnostics Tab 69
Digital 55
Gain 55
Offset 55
Processing 52

Disconnecting a Camera 9

E
Enabling and Disabling
Coefficients 12,55
Error Report 60
Exposure 22
Modes 21
Time 22
Exposure Control Tab 66
F
File 11,12
Loading Settings 12
Save Settings 11
Flat Field Correction 53
Frame Rate
Too Low 60
Troubleshooting 60
G
gain 51
Gain
Analog 54
Digital 55
GPIO
Control Bits 45
Control Block 23

Control Block
Programming Language

and Examples 27
Counter 42
Input Debouncers 44
Input Labels 24
Look-Up Table LUT 35
Output Labels 25
Pulse Generator 37
Rescaler 40

Grabbing Images 9
Continuous Mode 9
Snapshot Mode 9

H

Help 5

Help Menu Commands 77
High Sensitivity Mode 17
Horizontal Binning 18
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Image Acquisition

Starting 9

Stopping 10
Image Output Window 71
Image Processing

Overview 51
Image Processing Tab 67
Image Readout Tab 66
Installing QuickCam 7

L

Line
Rate 22
Loading 12
Camera Settings from a
Script File 12
Macro 57
Pixel Coefficients 12

Low Sensitivity Mode 17

M

Macro
Loading 57
Recording 56
Message Window 71

N

Network Device Window

71

nput Debouncers 44
Number of Bits 18
Offset

Analog 54
Overview Configuring

Image Readout 17
P
Pixel Coefficients 12

Loading 12

Resetting 12

Saving 12
Pulse Generator 37

Rebooting a Camera 10

Reconnecting a Camera 9

Recording a Camera
Settings Macro 56

Region of Interest

Setting 53
Viewing 53
Rescaler 40
Resetting 12
Pixel Coefficients 12
Resetting Camera 10
Resizing the Image 15
Restoring 11
Camera Settings 11

Running QuickCam 8

S

Save/Restore Tab 69
Saving 10,11, 12
Camera Settings 10
Pixel Coefficients 12
Settings to a Script File 11
Script File 11,12
Loading Settings 12
Saving Settings 11
Sensitivity Mode 17
Setting Individual Pixel
Coefficients 56
Shift Direction 18
Stopping Image
Acquisition 10
Support 5
Switching Between Video

and Test Patterns 61

T

Toolbar Commands 78
Troubleshooting Using
the Diagnostics Tab 62

U

Understanding the GPIO
Control Block 23

\'/

View Menu Commands 76,
77

Viewing a Image 15

virtual serial port 74

Virtural Serial Port 74

w

Welcome 5
Window_Commands 77
Wizard 53

Flat Field Correction 53
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y 4 Zooming In or Out of an
Image 16
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